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Fundraising is the lifeblood
of most GAA clubs and
counties. Without it, they
would struggle to survive.

This is where the GAA comes into its own and is in

a league of its own. GAA communities up and down
the country go into overdrive when called upon.
Whether it’s for a major capital project or simply for
funds to keep the club alive, they answer the call.

Our document is divided into an introduction
and 3 sections covering our 3P’s of Fundraising

INTRODUCTION
O01. PLAN

02. PUBLISH
03. PROMOTE

Our range of fundraising
tools include:

C&C donate
C&C|cairde|

C&:C shop|
C&C|draw

stripe PP PayPal

Important: to use any of the C&C fundraising tools, your club
will need to set up an account with a payment provider such
as Stripe or PayPal. Don’t worry, it’s really straightforward
to do and you can find out more:
https://clubandcounty.com/help-centre/how-to-add-a-
payment-gateway-to-your-site/
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03. PROMOTE

Clubs have never mattered more
to communities. Which means
fundraising activities have never
mattered more either.

Over the past 18 months, we’ve
been developing a range of tools
that will make your fundraising
easier. To get started, simply add
them to the C&C Club Template.

INTRODUCING THE
3 Ps OF FUNDRAISING

PLANNING

Everything we’ve developed is based on
one simple principle: getting traffic to your

website. PUBLISHING

To improve your fundraising, you need to
improve your traffic numbers. To do this,
everyone needs to treat your website as your
virtual clubhouse, your communication hub.
Driving traffic to your site is the most crucial
part of your growth strategy.

PROMOTION

The C&C Match Centre is a great tool in
driving traffic married with strong engaging
content such as regular news updates, match
reports etc. With regular traffic to your site
you can start to fund-raise using C&C Donate,
the focus of this guide. It’s a plugin that lives
permanently on your site giving you the ability
to fund-raise 24/7, 365 days a year.

The best way to maximise online donations is We WiS h yOU s Cl U b gOOd fO I’tu Nne
through individual campaigns and this guide is

going to show you exactly how to do that. and gOOd fundraisi Ng.

Club & County How to secure online Club donations

For more info visit clubandcounty.com/help-centre



In any club, it’s vital to balance your wants
and needs with the skills and resources
available. Consider carefully what your
club wants/needs before embarking

on your fundraising campaign. Decide
early on what you think is achievable

and plan accordingly.

Forming a fundraising committee is a great
start. Remember to find out what your
collective experience is. If it’s something
you have never done before, start small
and build up as you learn. Talk to other
clubs who have done it before - in our
experience, GAA clubs are always very
keen to share their knowledge.

A GAA club can be a force of nature
when properly prepared and focused

on a major project. But you should
never underestimate the work involved
and you definitely shouldn’t overstretch.
This will only lead to trouble!

People are the real key to success. In our experience, the
following people are indispensable:

The Project Chairperson:

Not necessarily your club chair but the person who will
oversee the project and maintain the focus.

The Creative:

The ideas person, someone who can think outside the box
and help communicate the story.

The Techie:

The one that understands the digital world.

The Salesperson/people:

There are people in your club that can sell show to the
Eskimos - get to know who they are!

Remember that Energy = Income. When the pace drops,
so does the income. Share the workload and keep a
steady pace and save some energy for the final sprint.
On major projects it’s the last few weeks that are critical.

Lists are your friend. Make a list of the projects or items
that you need money for. Include everything from capital
projects, equipment, events and charities to community
groups that your club is involved with.

"

\ |

Consider the tools and fundraising activities you have
available (or would like to make available) and develop
your strategy. You may adopt different tools and tactics
for the same project. For example, on a major capital
project you might include a range of events, direct
donations and maybe even a fundraising draw with all
funds going into one pot. At the other side of the scale,
there’s the example of a coffee morning for charity. In this
case, some members may not be able to attend but would
like to give something - with C&C Donate, you can give
this option on your website.

Match the tools to the project and get started. This is
where the real work begins. Getting someone to part
with cash is not an easy task. But as a very wise Tyrone
salesperson once said, “No just means not today.”

PROMOTE, PROMOTE and PROMOTE some more.
Marketeers historically would have talked about the
Rule of 7. Basically someone needs to see a piece of
communication 7 times before it registers with them
SO hever ever assume that everyone knows about your
project or campaign.
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What is a

campaign?

Q,

FlX & RES

Quicklinks: Ewvents Committees Play lotte

Donate to - Greencastle
Community Hub

Our new ‘GAA For All' space will provide an
open and accessible facility that will allow all
members of our community to take part in
recreational, cultural and educational
programmes as part of our club activities.

N\,  £100.00

0
20 /ﬂ' raised of £500 target by 1
supporters

fv (L) o SHARE

To make a donation please select a preset or
custom amount from the options below:

| £10 m £50 || £100 ‘ Custom |

Share

Our Story

The building will be fully inclusive with a
particular focus on our youth, those with

special needs and older people from the local
community of Greencastle. ;

This first phase of the project is a purpose built
area that will have a multi functional space for
recreational, educational, social, cultural and
health and wellbeing needs. The range of
services that will be able to be provided will
reflect those identified within the community

Your Cause.

Your Campaign
graphic/
photograph.

Your story intro.
Add a brief intro
to your campaign.

Your percentage bar
to check progress on
the funds raised.

Set for €20 or a
custom amount.

Your Story.



#% Dashboard

)2. PUBLISH

C&C/|fundraising|

W Club Assets

A Posts

Step ™t """5 Events Choose your Area

C&C Fundraising

Login to your Club Dashboard in
the usual way. On the left hand

EX Fundraising

navigation click the Fundraising . CE&C Donate
tab and you’ll see the list of Fundram'“g
available options. C J
Click C&C Donate Donations
C&C Shop

Club Shop

#® Dashboard

C&C fundraising|

cucdonte

Step 2: ¥ cub et
C&C Donate o

The C&C Donate window ) Events
will open and this is where E® Fundraising

your ongoing campaigns will Fundraising Date Donation ~ offiine cdi
Donations Planning PDF Name Created Goal Total Raised Donation Add Lipdata Settings
be stored. To create a new
Club Shop Crof an Chaisleain Glais - Published 08/03/23 £1,111 £0 Add Edit

campaign select the green
button top right

‘Create new Campaign’.
You can also ‘Edit’ an

existing campaign from here.

Cairde
Raffles

07 Media
B Pages
& Lotto
Galleries

¥ Downloads

€ Adverts

All Campaigns
Add Campaign
All Updates

Promotion PDF

Club 8 County How to secure online Club donations

For more info visit clubandcounty.com/help-centre



)2. PUBLISH

Step 3: Add Campaign

As we previously mentioned there are four parts to creating your
campaign. There are also tips on your dashboard to help you along.

Input your Campaign Name

Fill in the Amount you would like to raise

Add a brief introduction to your campaign

Tell your campaign story

Provide a graphic or photograph

Decide if you want to enable Campaign Updates
You can then save as a draft or publish.

From your main Donations screen you can also edit your campaign
at any time.

Step 4: Add Update

For long running campaigns

it’s important that you keep — cac(findraising|
your members and supporters v cuntuse -

up to date on the progress Do

of the project. This will also
encourage new donations. oo

All Upd,
u B 07 Media paates
]
. W Pages Add Offline Donation
]
Do n at I o n Galleries Promotion PDF

Cairde All Campaigns
Raffles Add Campaign

Select Fundraising Campaign:*

Choose Campaign

& Lotto

Amount Donated (£):*
¥ Downloads

Not all of your club members will A
be comfortable using the online i

tools we’ve provided, so we’ve T e
included a way to add off-line —

donations to the total that is L
displayed on your campaign
to keep your totals up to date.

i1l Analytics

@ Dashboard

C&C[fundraising|

W Club Assets

A Posts

£ Events ca&c|donate|

IE® Fundraising

Fundraising

Donations Planning PDF
Club Shop

Cairde All Campaigns
Raffles Add Campaign
ﬂ.: Nadla All Updates
M Pages

& Lotto

= Galleries Promotion PDF

¥ Downloads
€ Adverts

t§y Committees
B Products
Contact

¥@ Cairde Updates

" Complianz 2

GetWooPlugins

m WooCommerce

il Analytics
€ Marketing
M Appearance
K¢ Plugins

o Users

# Tools
Settings @

ACF

If checked a new name / message field will appear below for you to fill out and will apear on the main donation campaign page.

Add Campaign

Campaign Name: *

Amount you'd like to raise (£):

Campaign Tagline: *

Your Story: *

File » Edit + View » Insert~ Format« Tools » Table »

Paragraph v B I €€ = v

Av O

o]

Paragraph v U

Upload Featured Image: *

Add a Button

Jih
hh
%
25

!
o

This will be the cover image of your donation campaign

Visual

Text

| Choose file |N0 file chosen o

Do you plan to share update posts on your progress?

Enable Campaign Updates @& O

* = Required

& Dashboard

C&C|fundraising|

W Club Assets

A Posts

B Evaris ca&c[donate|

IE® Fundraising

Fundraising
Donations Planning PDF

Club Shop

Cairde All Campaigns

Raffles Add Campaign
All Updates
03 Media
* Add Update
Il Pages Add Offline Donation
& Lotto
Galleries Promotion PDF

¥ Downloads
€ Adverts

i Committees
B Products
Contact

¥a Cairde Updates

" Complianz 2

GetWooPlugins.

@ wooCommerce

il Analytics

Add Update

Title: *

Choose Update Campaign:

None selected

Update Details: *

Upload Featured Image: *

This will be the cover image of your donation campaign update.

\ Choose file \Nn file chosen

* = Required

Insert campaign name

How much do you

need to raise?

Campaign tagline: a brief
intro to the campaign

Tell the story of the
campaign, explain why
donations are important.

Add a picture or graphic.

If it’s a long running
campaign you can add
‘Updates’ to keep your
members and supporters
informed about progress.

Save as draft
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NEXT MATCH | Naomh Eoghan @ 19:15 Tue 2nd May QnQg 2] Login

Fix & Res Croi an Chaisledinn Ghlais History Membership Sponsorship Resources ~ Contact

Quicklinks: Events Committees Play lotto
Home / Dontations - making good things happen
‘ Dontations - making good things happen

Our club strives to improve the lives and well-being, not only for our members and supporters, but the community as a whole. Please play your
partin ‘making good things happen’. Select any of the campaigns listed below.

This is your central

HOw |t IOOKS CR@I' campaigns page. You can

On your site in desktop, tablet and mobile the DONATE icon has a o ot Wi e =3 have multiple campaigns
prominent position on the home page, in the main header navigation SR | running at the same time.
and a dedicated space in the body of your home page. All will direct the e ﬁ_ﬁ

user to your main Donations page.

Croi an Chaisleain Glais

NEXT MATCH | Naomh Eoghan @ 19:15 Tue 2nd May QnQo ) Login View Campaign Manag

MSLEAN
" “ GREENCASTLE GAA <

,eg An Caislean Glas agus Sperrin Og

Donate

News ~ Fix & Res Croi an Chaisleainn Ghlais History Membership Sponsorship Resources ~ Contact Re m e m b e r

Quicklinks: Events Committees Play lotto

You can edit a campaign at any time. Go to your dashboard and the main Fundraising page.
You’ll see the EDIT button far right of all your campaign listings.

Welcome to our new Club
WebSIte NEXT MATCH | Drumquin Wolfe Ton 15 Tue 9th May
20TH FEB 2023

wELy
%" GREENCASTLE GAA

g An Caislean Glas agus Sperrin Og Donate

We are pleased to announce that we are one of the 4
first clubs in Ireland to adopt the latest Club & County "@mm.

Communication Platform V10.2.
. ] News ~ Fix & Res Croi an Chaisledinn Ghlais History Membership Sponsorship Resources ~ Contact

Quicklinks: Events Committees Play lotto

. e i When you click on a
campaign it will bring you

to the Donation page, it will

explain your project and

Our new ‘GAA For All’ space will provide an open and = -
»
‘ ROI Q accessible facility that will allow all members of our -\ InVIte the user to DONATE'

AN CHAISLEAIN GHLAIS community to take part in recreational, cultural and

Donate to - Greencastle Community Hub

Match Centre View all >

NEXT MATCH LATEST MATCH UPCOMING MATCH

gt it el oy educational programmes as part of our club 20%
5 | activities.
TUE 2ND MAY 2023 SUN 30TH APR 2023 THU 4TH MAY 2023 ﬁ
Ladies Minor Grade 4 League 23 Ladies U14 Grade 4 League 23 Under 16 Grade 2 i To make a donation please select a preset or custom
Round 6 Round 8 Round 11 = s - amount from the options below:
L4
S SEI e - £10 m £50 || £100 | | Cust £100.00
Clann na An Eaglais, m ustom
nGael . - Naomh... = raised of £500 target
7 < ﬁ " <
Venue: Greencastle Venue: Aughabrack Venue: Pairc An tAthair Ui Conghalaigh Fv »
SHARE

Referee: Luke Darcy Referee: Odhran Gallen Referee: Justin Mc Kenna
Our Story
L]

Please support all our teams, players and coaches across all grades and codes. The building will be fully inclusive with a particular focus on our youth, those with special needs and older Suppo rters n
people from the local community of Greencastle.
) ) ) Anonymous

This first phase of the project is a purpose built area that will have a multi functional space for recreational, £100.00

H el us ma ke educational, social, cultural and health and wellbeing needs. The range of services that will be able to be provided
YOUR DONATIONS - . . _ : )

will reflect those identified within the community such as:
l Show More l

will make a
g OOd thlngs huge difference « Aspace for programmes and initiatives aimed at groups including older people (60+ years).
» Skills programmes for young people including Scor, Drama, Ceoltas, music lessons etc.
hap pen » Aspace for coach development programmes.

» Asuite of health and wellbeing/fitness and exercise initiatives




)3. PROMOTE

So you have successfully created a campaign.
Set your Goal, told the story and published to
your website and there’s even a big coloured
DONATE button on your home page!

Surely there’s nothing left to do but sit back
and watch the cash roll in?

If only it was that simple?

This is where part 3 of the plan kicks in -
PROMOTE.

When we are explaining the need for ongoing consistent
marketing to clubs, we always use the example of Coca
Cola. Over the past week you will have seen at least one
example of Coca Cola marketing. Surely a brand of this size
doesn’t need to consistently market, everyone will buy it
anyway. Well, the answer is the opposite. Coca Cola view
their marketing as vital as their secret recipe.

Don’t worry we’re not going to get you

to run TV ads or billboards, instead we’ll marry our
experience with your commitment and create what we
hope are good revenue generating campaigns.

On your website we will make it obvious to your members
that you have the ability to accept online donations. The
DONATION button is very prominent on the website and
there is also a leader-board ad in the centre of your site.

What you need to do now is make them aware of your

campaign, explain how you need their help and maybe
they will part with their hard earned cash.
Don’t underestimate the task at hand here.

Here are some of our top tips to make your online
Donations campaign successful.

We will also provide you with some tools and templates to
help, select the CLUB ASSETS button on your dashboard.

Our theme;
HELP US MAKE GOOD THINGS HAPPEN

FIX & RES DONATE

Quicklinks:  Bingo

Comhghairdeas Tyrone
Hurlers

2ND APR 2022

Comhghairdeas to Ciaran Lagan and the
Tyrone GAA Hurlers on their 2 point Win...

:
Match Centre jew 3

Help us make

~ happen

good things

YOUR DONATIONS
will make a
huge difference

DONATE

Club & County How to secure online Club donations
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)3. PROMOTE

Step 1 Launching
your campalgn

Depending on the size of the campaign this
could take the form of a press release plus
photo or you could arrange an actual event
depending on the size of your campaign.

Get into the habit of following the same procedure across all

your fundraising activities. You can tweak it as you go - find
out what works for you and your club and keep doing it.
The main reason for failure is lack of consistency.

Why not invite the local press and make a splash about
the upcoming project? Use your club contact list, email or
phone. It is important to let all your members know what
is happening and don’t be afraid to use all the channels
available to you.

No matter how much promotion you
do, someone will always say -
“l never heard about that!”

This will get the ball rolling and you can start to direct
people towards the website to make a donation.

Step 2 Use the
SHARE function

There is a built in SHARE pop up which is a
great function. Encourage your members to
use the SHARE function to widen the net for
Donations.

FOR AGE 14" 12

THE CLUB 15 ARRANGING CARDIAC SCREENING FOR OUR YOUTH MEMBERS.

Sharing is Caring

Sharing this page with your friends
could help us raise more in
donations.

Would you like to share now?

'f , 4 « SHARE

Club & County How to secure online Club donations
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A0 Ry Thank you for II\aking
//g good things
PROMOTE
n .
. Thank you for making P N " -J
PY )
Step 3 Social good things
media channels happen R
On your dashboard you will find your ’
C&C Canva templates in your club colours. 12:30 il = @)

These templates have blank areas for you
to add your campaign or simply thank
supporters who have donated.

<— Posts

WHY NOT DONATE ONLINE TODAY?
You can make a huge difference!

HSEW
F
W07 An Caisleann Glas

Use the C&C templates or create your own message and get
it out on all your social channels.

Do it regularly and be consistent.
Remember the Rule of 7, someone will need to see a post
quite few times before it registers with them.

Create a plan for when you post and how often.

Help us make )
good things "

Mix with the templates and project updates or simply add

-
the MAKING GOOD THINGS HAPPEN button over the top h pp m
of a photo. a e n Failte go dti An Caislean Glas
g 0D Cumann Naomp Padraig
- Qﬁ@) CHRISTMAS T |
[ 20 IF ApPeEAL 18
WHY NOT DONATE ONLINE TODAY?
You can make a huge difference!
4 mn
19 Likes
You can now donate online to our development ... more
Club & County How to secure online Club donations For more info visit clubandcounty.com/help-centre

2 days ago



)3. PROMOTE

Step 4
Use Video

Video is a great way of grabbing attention. If it
IS a building project for example use video or

photography to track progress. n

Step 5 Project
Ambassadors

If your club has a high profile current/ex player
or a celebrity connection don’t be afraid to
use them to promote the campaign or project.
The Skryne GAA example is our C&C Draw
function but the concept is the same.

Use the Make Good Things Happen brand to tell the story.
Print it out and get teams, managers to hold the brand in
photos or videos.

@-‘ @A News. Fix&Res OurClub~ Downloads~ Shop Contact

John Deere 6120M Tractor
(worth €120,000) or
Cash Alternative of €100,000.

Ownership Rights to a Gavin Cromwell Center Parcs Holiday
Voucher to the value of

€3,000.

trained Racehorse for 1 Year
or Cash alternative of €10,000.

Draw Ambassadors

Supporting

Young people’s
health in mind

Trevor Giles

Meath Legend and 2 time
All-Ireland Winner

Nina Carberry

Irish Grand National Winner and
Dancing With the Stars Champion

Step 6
Project updates

Even if you are just taking a screen shot of the
progress dial on the website it is a great way of
iInforming your members and supporters how
the project is progressing. It is an opportunity to
keep telling your story and all the work going on.

Keep repeating steps 2-6
until the goal has been reached.

Omagh St. Enda’s Health & Wellbeing, in
association with The Cormac Trust and Friends
of Sinead are offering all of our Youth aged 14+
(as of 1st July 2022), Cardiac Screening to

There will be a number of
bonus prizes up for grabs.
More details to follow.

minimise the risk of Sudden Cardiac Event.

£60
30/0 raised of £2,000 target by
2 supporters
f v | @ SHARE

To make a donation please select a preset or
custom amount from the options below:

£10 || £100 m £50 || Custom

Share

gi 'I;\r:_',

i 54
G
=T
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